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Safety Information

The attached "Safety Precautions" manual contains important information about the safe and correct
use of the ScanSnap. Make sure that you read and understand it before using the ScanSnap.

Safety Information
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Manuals

Read the following manuals according to your needs when using the ScanSnap.

Before Using the ScanSnap
Manual Description and Location

Safety Precautions This manual contains important information about the safe use of the ScanSnap.
Make sure you read this manual before using the ScanSnap.
This manual is included in the package.

In addition, when the software is already installed, this manual can be accessed as
follows: From the sidebar in Finder, select [Applications] → [ScanSnap Manuals], and
then double-click [iX500 Safety Precautions].

When Setting Up the ScanSnap
Manual Description and Location

ScanSnap iX500 Getting
Started

This manual explains the setup procedure from the moment you open the package to
testing the operations.
Getting Started is included in the package.

In addition, when the software is already installed, this manual can be accessed as
follows: From the sidebar in Finder, select [Applications] → [ScanSnap Manuals], and
then double-click [iX500 Getting Started].

When Operating the ScanSnap
Manual Description and Location

ScanSnap iX500 Basic
Operation Guide (this
manual)

This manual explains the basic operations and cleaning procedure for the ScanSnap.

ScanSnap Advanced
Operation Guide

This manual describes operations including various scanning methods and useful
usages of the ScanSnap.
You can refer to this manual at the following website.
http://www.pfu.fujitsu.com/imaging/downloads/manual/advanced/mac/en/common/
index.html

ScanSnap Manager Help This Help file describes the windows, operational troubles and the solutions, as well as
messages of the ScanSnap Manager.
This manual can be accessed by one of the following methods:

l Click the ScanSnap Manager icon  in the Dock while holding down the
[control] key on the keyboard, and select [Help] → [Help] from the "ScanSnap
Manager Menu" (page 39).

l Click the Help button ( ) for ScanSnap Manager.
l Select [Help] in the menu bar → [ScanSnap Manager Help].

ScanSnap Wireless Setup
Tool Help

This Help file explains about operations, operational troubles and their solutions,
windows, and messages of the ScanSnap Wireless Setup Tool.

Click the Help button ( ) in each window.

Manuals
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When Saving Scanned Images to a Mobile Device
Manual Description and Location

ScanSnap Basic Operation
Guide (Mobile Connection
for iOS)

This manual describes operations to be performed on an iOS-based mobile device
when you save scanned images to the mobile device.
This manual can be accessed by the following method:
1. Start up ScanSnap Connect Application on the mobile device.
a The [File List] screen appears.

2. Tap .
a The [Information] screen appears.

3. Tap the [Help] button.

ScanSnap Basic Operation
Guide (Mobile Connection
for Android)

This manual describes operations to be performed on an Android-based mobile device
when you save scanned images to the mobile device.
This manual can be accessed by the following method:
1. Start up ScanSnap Connect Application on the mobile device.
a The [File List] screen appears.

2. Tap .
a The menu appears.

3. Tap [Help].

When Updating the Software
Manual Description and Location

ScanSnap Online Update
Help

This Help file describes the operations, windows, and messages of ScanSnap Online
Update.
This Help file can be accessed by one of the following methods:

l Click the Help button ( ) of ScanSnap Online Update.
l Select [Help] in the menu bar → [ScanSnap Online Update Help].

When Using Related Applications
Manual Description and Location

ScanSnap Organizer Help This Help file describes the operations, windows, and messages of ScanSnap
Organizer.
This Help file can be accessed by selecting [Help] in the menu bar → [ScanSnap
Organizer Help].

CardMinder Help This Help file describes the operations, windows, and messages of CardMinder.
This Help file can be accessed by selecting [Help] in the menu bar → [CardMinder
Help].

Nuance PDF Converter for
Mac Help

This Help file can be accessed by selecting [Help] in the menu bar → [Nuance PDF
Converter Help].

Manuals
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Trademarks

Microsoft, Windows, Windows Vista, Excel, PowerPoint, Outlook, SharePoint, Windows Live,
Internet Explorer, and OneDrive are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

Word is the product of Microsoft Corporation in the United States.

Apple, App Store, the Apple logo, Mac, Mac OS, OS X, macOS, iPad, iPhoto, iPod touch, and
iTunes are trademarks of Apple Inc.

Nuance, the Nuance logo and Dragon are trademarks and/or registered trademarks of Nuance
Communications, Inc. and/or its affiliates in the United States and/or other countries.

Intel and Intel Core are registered trademarks or trademarks of Intel Corporation in the United States
and other countries.

ABBYY™ FineReader™ Engine © ABBYY. OCR by ABBYY

ABBYY and FineReader are trademarks of ABBYY Software, Ltd. which may be registered in some
jurisdictions.

Evernote is a registered trademark or trademark of Evernote Corporation.

Google, Android, Google Play, and Google Drive are registered trademarks or trademarks of Google
Inc. Use of these registered trademarks or trademarks is subject to Google Permissions.

Salesforce, the Salesforce logo, and Salesforce CRM are registered trademarks or trademarks of
salesforce.com, inc. in the United States and other countries.

Wi-Fi, Wi-Fi Protected Setup, and the Wi-Fi Protected Setup logo are trademarks of Wi-Fi Alliance.

Amazon is a trademark of Amazon.com, Inc. or its affiliates.

Besides the software authored by the product developer (PFU Limited), the ScanSnap contains
other free software, such as software copyrighted under the GNU General Public License (GPL) or
the GNU Lesser General Public License (LGPL). For details concerning the conditions of the
licenses, refer to "Terms and Conditions for End User License" (file name: OSS_License.pdf)
contained in the installation folder of ScanSnap Manager.

ScanSnap, the ScanSnap logo, ScanSnap Manager, ScanSnap Organizer, CardMinder, and Rack2-
Filer are registered trademarks or trademarks of PFU Limited in Japan.

Other company names and product names are the registered trademarks or trademarks of the
respective companies.

Trademarks
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Manufacturer

PFU Limited

YOKOHAMA i-MARK PLACE, 4-4-5 Minatomirai, Nishi-ku, Yokohama, Kanagawa, 220-8567, Japan

© PFU Limited 2014-2017

Manufacturer
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Symbols Used in This Manual

The following indications are used in this manual to obviate any chance of accident or damage to
you and people near you, and your property. Warning labels indicate the warning level and
statements. The symbols indicating warning levels and their meanings are as follows.

Indication Description

�������

This indication alerts operators of an operation that, if not strictly observed, may result
in severe injury or death.

�������

This indication alerts operators of an operation that, if not strictly observed, may result
in safety hazards to personnel or damage to the product.

Symbols Used in This Manual
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Arrow Symbols in This Manual

Right-arrow symbols (→) are used to connect icons or menu options you should select in
succession.

Example: From the sidebar in Finder, select [Applications] → [ScanSnap].

Arrow Symbols in This Manual

11



Screen Examples in This Manual

The screenshots used in this manual are of OS X El Capitan v10.11.

The actual windows and operations may differ depending on the operating system.

The screen examples in this manual are subject to change without notice in the interest of product
development.

If the actual window differs from the screen examples in this manual, operate by following the actual
displayed screen.

Screen Examples in This Manual
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Abbreviations Used in This Manual

Also, the following abbreviations are used in this manual.

Abbreviation Used Designation

Mac OS macOS Sierra v10.12
OS X El Capitan v10.11
OS X Yosemite v10.10
OS X Mavericks v10.9

Word Microsoft® Word 2016 for Mac
Microsoft® Word for Mac 2011

Excel Microsoft® Excel® 2016 for Mac
Microsoft® Excel® for Mac 2011

PowerPoint Microsoft® PowerPoint® 2016 for Mac
Microsoft® PowerPoint® for Mac 2011

Nuance Nuance®

ABBYY FineReader for
ScanSnap

ABBYY FineReader for ScanSnap™
All the descriptions in this manual assume the usage of ABBYY FineReader for
ScanSnap bundled with the ScanSnap. Unless otherwise specified, the term ABBYY
FineReader for ScanSnap refers to the ABBYY FineReader for ScanSnap bundled
with the ScanSnap.
Note that ABBYY FineReader for ScanSnap may be upgraded without notice. If the
descriptions in this manual differ from the actual displayed screens, refer to the
ABBYY FineReader for ScanSnap User's Guide.

Google Drive Google Drive™
Android Android™
WPS Wi-Fi Protected Setup™
Wireless access point Wireless access point

Wireless router

ScanSnap Color Image Scanner ScanSnap iX500

Abbreviations Used in This Manual
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What You Can Do with the ScanSnap

Scanning Multiple Documents
A document stack with a thickness of 5 mm (0.2 in.) or less (for A4 or smaller sizes: up to 50 sheets
with 80 g/m2 [20 lb] paper weight) can be loaded into the ScanSnap for scanning.

For details, refer to "Scanning a Document" (page 16).

Scanning Documents That Cannot Be Loaded Directly in the
ScanSnap
You can use the optional Carrier Sheet to scan the following documents.

l Documents that are larger than A4/Letter size and not larger than A3 size

For details, refer to "Scanning Documents Larger Than A4 or Letter Size" (page 83).

l Documents that can be damaged quite easily such as photographs, or non-standard size
documents such as clippings

What You Can Do with the ScanSnap
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For details, refer to "Scanning Documents Such as Photographs and Clippings" (page 87).

Connecting the ScanSnap via Wireless LAN
You can connect the ScanSnap and a computer or mobile device via wireless LAN.

To configure the wireless settings for the ScanSnap, use the ScanSnap Wireless Setup Tool, which
is installed together with ScanSnap Manager.

For details, refer to "Connecting the ScanSnap via Wireless LAN" (page 48).

What You Can Do with the ScanSnap
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Scanning a Document

You can load documents such as handouts for meetings or business cards directly in the ScanSnap
for scanning.

For details about documents that can be scanned, refer to "Documents That Can Be Loaded Directly
into the ScanSnap" (page 57).

1. If you are loading multiple sheets, check the number of sheets.
The maximum number of sheets in the ScanSnap is as follows:

For A4 or smaller sizes: Up to 50 sheets can be loaded (with paper weight of 80 g/m2 [20 lb]
and thickness of the document stack under 5 mm [0.2 in.]).

ATTENTION
If you try to scan more than the maximum amount that can be loaded, the following problems
may occur:
l Files cannot be properly created due to excessive file size.
l Paper jams occur during scanning.

2. Fan the documents.
1. Hold both ends of the documents and fan them a few times.

2. Rotate the documents 90 degrees and fan them in the same manner.

3. Straighten the edges of the documents and slightly displace the top edges at
an angle.

BackAt an Angle

Feed Direction

ATTENTION
Paper jams or damage to documents may occur if you scan the documents without aligning the
edges first.

Scanning a Document
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4. Open the ADF paper chute (cover) of the ScanSnap.

ADF Paper Chute (Cover)

a The [Scan] button flashes in blue. The button returns to being lit normally when document
scanning is enabled.

In addition, the ScanSnap Manager icon in the Dock changes from  to .

5. Pull the stacker towards you.

Stacker

6. Depending on documents to scan, pull out the extension on the ADF paper
chute (cover) and open the stacker.

Scanning a Document
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Extension

Stacker

7. Load the documents in the ADF paper chute (cover).
Load the documents face-down and top-first with their back facing you. Adjust the number of
documents so that they do not go beyond the reference marks and are kept within the side
guides when they are loaded.

Side Guide

ATTENTION
Do not accumulate more than 50 sheets (with paper weight of 80 g/m2 [20 lb]) in the stacker.

8. Adjust the side guides to the width of the documents.
Hold each side guide in the middle to adjust them. Otherwise, the documents may be fed
skewed.

Scanning a Document
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Documents

9. Press the [Scan] button on the ScanSnap to start a scan.

ATTENTION
Do not perform the following operations during scanning. Doing so will stop scanning.
l Connect or disconnect the ScanSnap and other USB devices.
l Close the ADF paper chute (cover).
l Switch users.
l Allow the computer to enter sleep mode.

a The [Scan] button on the ScanSnap flashes in blue while the documents are being
scanned.

The [ScanSnap Manager - Image scanning and file saving] window appears.

a The Quick Menu appears when the scanning is completed.

10. In the Quick Menu, click the icon of the application to link with ScanSnap
Manager.
For details about linking CardMinder with ScanSnap Manager, refer to "Saving Business Cards
to a Computer" (page 80).

Scanning a Document
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a The selected application starts up. For details, refer to the Advanced Operation Guide.

ATTENTION
l You cannot start scanning when the Quick Menu is displayed. Either select an icon from the

Quick Menu and finish the process, or close the Quick Menu before you perform the next
scan.

l Do not move, delete, or rename scanned images using other applications while the Quick
Menu is displayed.

HINT

l Clicking  displays the description of an application. Placing the mouse cursor over the
icon of another application displays the description of the application.

l Performing a scan while an application that can be automatically linked with is active
automatically starts the linkage between ScanSnap Manager and the application.
For details, refer to the Advanced Operation Guide.

Scanning a Document
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Scanning a Long Page

Documents up to 863 mm (34 in.) in length can be scanned.

For details about documents that can be scanned, refer to "Documents That Can Be Loaded Directly
into the ScanSnap" (page 57).

HINT
For details about how to load documents that are 360 mm (14.17 in.) or less in length, refer to
"Scanning a Document" (page 16).

1. Open the ADF paper chute (cover) of the ScanSnap.

ADF Paper Chute (Cover)

a The [Scan] button flashes in blue. The button returns to being lit normally when document
scanning is enabled.

In addition, the ScanSnap Manager icon in the Dock changes from  to .

2. Pull the stacker towards you.

Stacker

3. Pull out the extension on the ADF paper chute (cover) and open the stacker.

Scanning a Long Page
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Extension

Stacker

4. Load only one document in the ADF paper chute (cover).
Hold the document with your hand so that it does not fall out of the ADF paper chute (cover).

5. Press the [Scan] button on the ScanSnap (for three seconds or longer) until
the button flashes in blue to start a scan.

ATTENTION
l Secure enough space where the scanned documents are ejected from the ScanSnap, and

pick up the documents with your hands to prevent them from falling off the unit where the
ScanSnap is placed on.

Scanning a Long Page
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l Do not perform the following operations during scanning. Doing so will stop scanning.
- Connect or disconnect the ScanSnap and other USB devices.
- Close the ADF paper chute (cover).
- Switch users.
- Allow the computer to enter sleep mode.

HINT
When you scan the first page as a long page and continue scanning, the subsequent documents
are also scanned as long pages.

a The [Scan] button on the ScanSnap flashes in blue while the documents are being
scanned.

The [ScanSnap Manager - Image scanning and file saving] window appears.

a The Quick Menu appears when the scanning is completed.

6. In the Quick Menu, click the icon of the application to link with ScanSnap
Manager.

Scanning a Long Page
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When you select , you can manage scanned images by folder with ScanSnap
Organizer.

For details, refer to "Managing Paper Documents by Folder on a Computer" (page 77).

a The selected application starts up. For details, refer to the Advanced Operation Guide.

ATTENTION
l You cannot start scanning when the Quick Menu is displayed. Either select an icon from the

Quick Menu and finish the process, or close the Quick Menu before you perform the next
scan.

l Do not move, delete, or rename scanned images using other applications while the Quick
Menu is displayed.

HINT

l Clicking  displays the description of an application. Placing the mouse cursor over the
icon of another application displays the description of the application.

l Performing a scan while an application that can be automatically linked with is active
automatically starts the linkage between ScanSnap Manager and the application.
For details, refer to the Advanced Operation Guide.

Scanning a Long Page
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Scanning Documents of Different Widths or
Lengths in One Batch

Documents of different widths or lengths can be scanned in one batch.

For details about documents that can be scanned, refer to "Documents That Can Be Loaded Directly
into the ScanSnap" (page 57).

1. Open the ADF paper chute (cover) of the ScanSnap.

ADF Paper Chute (Cover)

a The [Scan] button flashes in blue. The button returns to being lit normally when document
scanning is enabled.

In addition, the ScanSnap Manager icon in the Dock changes from  to .

2. Pull the stacker towards you.

Stacker

3. Depending on documents to scan, pull out the extension on the ADF paper
chute (cover) and open the stacker.

Scanning Documents of Different Widths or Lengths in One Batch
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Extension

Stacker

4. Click the ScanSnap Manager icon  in the Dock while holding down the
[control] key on the keyboard, and then select [Settings] from the "ScanSnap
Manager Menu" (page 39).
a The ScanSnap setup window appears.

5. In the [Paper] tab, select [Automatic detection] in [Paper size].

6. Select [None] in [Multifeed Detection].

Scanning Documents of Different Widths or Lengths in One Batch
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7. Click the [Apply] button in the ScanSnap setup window.

8. Click  at the upper left of the window to close the ScanSnap setup window.

9. Load documents in the ScanSnap.
1. Align the edges of the documents.

2. Load the documents at the center of the ADF paper chute (cover).

Scanning Documents of Different Widths or Lengths in One Batch
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ATTENTION
l Load all documents over one another above the pick roller (center). Documents that are not

loaded above the pick roller cannot be fed.

Incorrect

Pick Roller's Width

l Adjust the side guides to the widest document. If the side guides are not adjusted properly, a
paper jam may occur.

l Load smaller documents so that they can be scanned straight.
If the documents are skewed during scanning, the following problems may occur:
- Part of the document does not appear in the scanned image
- Slant lines appear in the scanned image
- The documents are scanned in a wrong paper size
If the documents are not scanned straight, it is recommended that you select the [Continue
scanning after last page] checkbox in the [Scanning] tab of the "ScanSnap Setup Window"
(page 41), separate the documents by their widths, and scan them in different batches.

10. Press the [Scan] button on the ScanSnap to start a scan.

ATTENTION
Do not perform the following operations during scanning. Doing so will stop scanning.
l Connect or disconnect the ScanSnap and other USB devices.
l Close the ADF paper chute (cover).
l Switch users.
l Allow the computer to enter sleep mode.

a The [Scan] button on the ScanSnap flashes in blue while the documents are being
scanned.

The [ScanSnap Manager - Image scanning and file saving] window appears.

Scanning Documents of Different Widths or Lengths in One Batch
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a The Quick Menu appears when the scanning is completed.

11. In the Quick Menu, click the icon of the application to link with ScanSnap
Manager.

When you select , you can manage scanned images by folder with ScanSnap
Organizer.

For details, refer to "Managing Paper Documents by Folder on a Computer" (page 77).

a The selected application starts up. For details, refer to the Advanced Operation Guide.

Scanning Documents of Different Widths or Lengths in One Batch
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ATTENTION
l You cannot start scanning when the Quick Menu is displayed. Either select an icon from the

Quick Menu and finish the process, or close the Quick Menu before you perform the next
scan.

l Do not move, delete, or rename scanned images using other applications while the Quick
Menu is displayed.

HINT

l Clicking  displays the description of an application. Placing the mouse cursor over the
icon of another application displays the description of the application.

l Performing a scan while an application that can be automatically linked with is active
automatically starts the linkage between ScanSnap Manager and the application.
For details, refer to the Advanced Operation Guide.

Scanning Documents of Different Widths or Lengths in One Batch
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ScanSnap Overview

This section provides an overview that you should be aware of before operating ScanSnap.

l "Parts and Functions" (page 32)

l "System Requirements" (page 34)

l "Overview of the Software Related to the ScanSnap" (page 36)

l "How to Install the Software" (page 37)

l "ScanSnap Manager Icon" (page 38)

l "ScanSnap Manager Menu" (page 39)

l "ScanSnap Setup Window" (page 41)

l "Turning the ScanSnap On or Off" (page 42)

l "Connecting the ScanSnap via Wireless LAN" (page 48)

l "Documents to Scan" (page 56)

ScanSnap Overview
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Parts and Functions

This section explains the names and functions of the ScanSnap parts.

Front

3

1

2

5

4

6

7

8

No. Name Description

1 ADF paper chute (cover) (*1) Open it to use the ScanSnap.
Opening it turns on the ScanSnap. Then, you can load a document
on it.

2 ADF top section Open it to remove jammed documents, replace the Roller Set, or
clean the inside of the ScanSnap.

3 Extension Pull out when scanning long documents.

4 Side guide Adjust to the width of documents to prevent them from getting
skewed.

5 ADF release tab Pull this tab to open the ADF top section.

6 [Scan] button (*1) Starts scanning. Can be pressed even when the stacker is closed.
Indicates the status of the ScanSnap as follows:
Blue (lit): Ready
Blue (flashing): Scanning
Orange (flashing): Error

Parts and Functions
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No. Name Description

7 Wi-Fi indicator Indicates the connection status between the ScanSnap and your
wireless access point as follows:
Blue (lit): Ready
Blue (flashing): Standby
Orange (lit): Not Connectable
Orange (flashing): Not Connectable (WPS error)

8 Stacker Open to use the stacker.
Stacks up the ejected documents.

*1: When the ScanSnap has turned off automatically because of the automatic power off function,
either press the [Scan] button (this will not start scanning), or close the ADF paper chute (cover),
then open it again to turn the ScanSnap back on.

For details, refer to "Automatic Power OFF" (page 47).

Back

9

10

11
12
13
14
15

No. Name Description

9 Tape seal Remove this tape seal after installing the software.

10 Security cable slot Used to connect an anti-theft security cable (commercially available).

11 Power connector Used to connect a power cable.

12 USB connector Used to connect a USB cable.

13 Ventilation port Holes for ventilating hot air from inside the ScanSnap.

14 WPS button Press this button to connect to a WPS compatible wireless access
point by using the push button method.

15 Wi-Fi switch Turn this switch on to connect the ScanSnap to a wireless LAN.

Parts and Functions
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System Requirements

The ScanSnap has the following system requirements.

For the latest information on requirements, please visit the ScanSnap Support Site at:

http://scansnap.fujitsu.com/g-support/en/

Operating system (*1) (*2) macOS Sierra v10.12.1 or later (*3)
OS X El Capitan v10.11
OS X Yosemite v10.10
OS X Mavericks v10.9 (v10.9.5 or later recommended)
OS X Mountain Lion v10.8 (v10.8.5 or later recommended)
Mac OS X Lion v10.7 (v10.7.5 or later recommended)
Mac OS X Snow Leopard v10.6 (v10.6.8 or later recommended) (*4)

CPU Intel® Core™ i5 2.5 GHz or higher

Memory 4 GB or more

Display resolution 1024 × 768 pixels or higher

Disk space Free space required to install the software bundled with the ScanSnap is as
follows: (*5)
l ScanSnap Manager: 640 MB
l ScanSnap Organizer: 95 MB
l CardMinder: 600 MB
l ABBYY FineReader for ScanSnap: 980 MB
l ScanSnap Online Update: 20 MB
l OCR Pack (*6)
l ScanSnap iX500 Basic Operation Guide: 100 MB
l Nuance PDF Converter for Mac: 110 MB

USB port USB 3.0 /USB 2.0/USB 1.1

*1: Updating Mac OS to the latest version is recommended.

*2: For the system requirements of the PDF editing software, refer to the following:

How to Install PDF Editing Software

http://www.pfu.fujitsu.com/imaging/downloads/manual/install/en

*3: ABBYY FineReader for ScanSnap 5.0 is not supported.

*4: ScanSnap Organizer is not supported.

*5: To save scanned images, more free space is required.

For details about estimated image data size, refer to the ScanSnap Manager Help.

*6: By installing the OCR Pack, you can add extra languages to recognize text.

For the amount of free space required to install the OCR Pack, refer to the following:

http://www.fujitsu.com/global/support/products/computing/peripheral/scanners/scansnap/
software/ocrpack-setup.html

ATTENTION
l If the system requirements above are not satisfied, the ScanSnap may not operate.
l If a USB port on the keyboard or on the monitor is in use, the ScanSnap may not operate.
l When using a commercially available USB hub, use a type that is powered from an electrical power

supply (and that comes with an adapter).
l Scanning speed decreases in the following cases:
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- The CPU or the memory does not meet the recommended specifications.
- The version of the USB port or the USB hub is USB 1.1.

l To scan a document, a disk space that is approximately three times larger than the size of the file
to be saved is required.
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Overview of the Software Related to the ScanSnap

This section gives an overview of each bundled software and their functions. You can edit, manage,
and arrange the scanned image by using the following software:

ScanSnap Manager
This scanner driver is required to scan documents with the ScanSnap. Scanned images can be
saved as PDF or JPEG files to a computer.

You need to have ScanSnap Connect Application installed on your mobile device to save PDF or
JPEG files to your mobile device.

You can download ScanSnap Connect Application for your mobile device from its application
market.

ScanSnap Organizer
You can use this application to display image data (PDF or JPEG files) in a list, create folders, and
arrange files as you like.

CardMinder
You can use this application to efficiently digitalize a large number of business cards.

Text recognition can be performed on business cards and you can create a database to facilitate
card data management and searches. Data in the database can be printed and linked with various
applications. The data can be also shared with PIM (Personal Information Manager), such as
Contacts.

ABBYY FineReader for ScanSnap
This application can perform text recognition on the scanned images using OCR (Optical
Character Recognition) to convert the image data to Word, Excel, or PowerPoint files that can be
edited.

ScanSnap Online Update
This application checks whether the latest updates or software programs are available on the
download server. When the latest updates or software programs are available, you can
automatically apply updates or download and install the software programs manually.

Evernote for Mac
You can easily save files in Evernote using the ScanSnap.

Dropbox for Mac
You can easily save files to your Dropbox folder using the ScanSnap.

Nuance PDF Converter for Mac
This is a application for creating, editing, managing, and utilizing PDF format electronic
documents.

Overview of the Software Related to the ScanSnap
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How to Install the Software

When you insert the Setup DVD-ROM into the DVD-ROM drive on your computer, the [ScanSnap]
window appears.

ATTENTION
l Do not connect the ScanSnap to the computer before installing the software. Doing so may cause

the ScanSnap not to be recognized by the computer. In that case, install the software, and then
reconnect the ScanSnap to the computer.

l If a DVD-ROM drive is not available, the installers for the software programs can be downloaded
from the following web page.
http://scansnap.fujitsu.com/g-support/en/

The functions of each button in the [ScanSnap] window are as follows.

Icon Function

ScanSnap Starts installing software.

Other Software Displays the [Other Software] window. From this window, you can access the
download web pages of the software programs.

Readme Displays the Readme file.

Manuals The [Manuals] window appears. You can refer to Safety Precautions, Getting Started,
the Basic Operation Guide (this manual), and the Advanced Operation Guide.

How to Install the Software
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ScanSnap Manager Icon

When ScanSnap Manager is running, the ScanSnap Manager icon is displayed in the Dock.

The ScanSnap Manager icon indicates whether or not ScanSnap Manager is successfully
communicating with the ScanSnap. The appearance of the icon changes according to the
communication status as shown below.

This manual assumes that the ScanSnap is connected to a computer with a USB cable.

Communication Status ScanSnap Manager Icon

Communicating When the ScanSnap is connected to a computer with a USB cable

When the ScanSnap is connected to a computer via wireless LAN

Not communicating

When the ScanSnap is connected to a mobile device via wireless
LAN

HINT
Turn the ScanSnap on to begin communication between ScanSnap Manager and the ScanSnap. For
details about how to turn on the ScanSnap, refer to "Turning the ScanSnap On" (page 43).

You can display the menu for scanning documents and ScanSnap Manager settings from the
ScanSnap Manager icon.

l Clicking while holding down the [control] key on the keyboard

Displays the "ScanSnap Manager Menu" (page 39).

l Clicking

Displays the Profile menu.

For details, refer to the Advanced Operation Guide.

ScanSnap Manager Icon

38



ScanSnap Manager Menu

This menu appears when you click the ScanSnap Manager icon  in the Dock while holding
down the [control] key on the keyboard.

Click while pressing the [control]
key on the keyboard

Item Function

Duplex Scan Scans both sides of the document. Follows the settings configured in [Settings].

Simplex Scan Scans only one side of the document. Follows the settings configured in [Settings].

Settings Displays the "ScanSnap Setup Window" (page 41). You can configure the scan
settings in this window.

Profile Displays the Profile menu.
You cannot select this when the [Use Quick Menu] checkbox is selected in the
ScanSnap setup window.

Profile Management Displays the [ScanSnap Manager - Profile Management] window.
You cannot select [Profile Management] when the [Use Quick Menu] checkbox is
selected in the ScanSnap setup window.
For details, refer to the Advanced Operation Guide.

Connect by Wi-Fi Displays the [ScanSnap Manager - Connect by Wi-Fi] window.
You can connect the ScanSnap to a computer via wireless LAN. This cannot be
selected when the ScanSnap is connected to a computer via a USB cable.
For details, refer to "Connecting the ScanSnap via Wireless LAN" (page 48).

Check consumable status Displays the [ScanSnap Manager - Check consumable status] window.
You can reset the consumable counters after replacing the consumables.

Preferences Displays the [ScanSnap Manager - Preferences] window.

ScanSnap Manager Menu
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Item Function

Help Displays the following menu:
l Help

Opens the ScanSnap Manager Help.
l Troubleshooting

Displays [Troubleshooting] in the ScanSnap Manager Help.
l ScanSnap Portal Site

Opens the ScanSnap global homepage (http://scansnap.fujitsu.com).
l About ScanSnap Manager

Displays the [ScanSnap Manager - Version Information] window.
l ScanSnap information

Displays the [ScanSnap Manager - Scanner and driver information] window.
Displayed when the ScanSnap and computer are connected.

l Online Update
Starts the ScanSnap Online Update.
For details, refer to "Updating the Software" (page 116).

To establish connection Displayed when ScanSnap Manager is not communicating with the ScanSnap
correctly.

Options Displays the following menu:
l Keep in Dock

Adds the ScanSnap Manager icon  to the Dock.
l Open at Login

Automatically launches ScanSnap Manager when the computer is started up or
logged in.

l Show in Finder
Displays the contents of the [ScanSnap] folder by using the Finder.

Show All Windows Shows all windows from ScanSnap Manager in thumbnails.

Hide/Show Hides or shows all windows from ScanSnap Manager.

Quit Quits ScanSnap Manager.

ScanSnap Manager Menu
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ScanSnap Setup Window

When you click the ScanSnap Manager icon  while holding down the [control] key on the
keyboard, and then select [Settings] from the "ScanSnap Manager Menu" (page 39), the following
ScanSnap setup window appears.

In the ScanSnap setup window, you can use the [Use Quick Menu] checkbox to specify whether or
not to use the Quick Menu. You can also use the profile buttons and detail setting tabs to specify
scan settings according to your scanning needs.

For details, refer to the ScanSnap Manager Help.

Profile Buttons

Detail Setting Tabs

ScanSnap Setup Window
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Turning the ScanSnap On or Off

This section explains how to turn the ScanSnap on or off.

l "Turning the ScanSnap On" (page 43)

l "Turning the ScanSnap Off" (page 45)

l "Sleep Mode" (page 46)

l "Automatic Power OFF" (page 47)

Turning the ScanSnap On or Off
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Turning the ScanSnap On

1. Turn on the computer.

HINT
If you connect the ScanSnap and a mobile device via a wireless LAN and then scan a document,
you do not have to turn on the computer.

a The computer starts up and the ScanSnap Manager icon  appears in the Dock.

HINT

l If the ScanSnap Manager icon  is not displayed in the Dock, click [Applications] from the
sidebar in Finder, click [ScanSnap], and then double-click [ScanSnap Manager].

l If ScanSnap Manager does not automatically start when you log in to the computer, display
the [System Preferences] window and select [Users & Groups] → [Current User] → [Login

Items] → [ ] → [ScanSnap] → [ScanSnap Manager].

2. Open the ADF paper chute (cover) of the ScanSnap to turn the power on.

Example: When a USB cable is used for connection

a The [Scan] button flashes in blue. The button returns to being lit normally when document
scanning is enabled.

In addition, the ScanSnap Manager icon in the Dock changes from  to .

ATTENTION
With some computers, the initialization of the ScanSnap may be performed several times when
the computer is started up.

Turning the ScanSnap On or Off
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HINT

l It may take more time for the ScanSnap Manager icon in the Dock to change to 
depending on computer performance, operating environment, or loading, for example, when
many software programs are running at the same time.

l When the ScanSnap is turned on, a notification window notifies you of the ScanSnap's
communication status.
To disable notifications of the ScanSnap's communication status, change the setting in the
following procedure:

1. Click the ScanSnap Manager icon  in the Dock while holding down the [control] key
on the keyboard, and then select [Preferences] from the "ScanSnap Manager Menu"
(page 39).
a The [ScanSnap Manager - Preferences] window appears.

2. Clear the [Notify of the communication status] checkbox in the [Status Display] list.

Turning the ScanSnap On or Off

44



Turning the ScanSnap Off

1. Close the ADF paper chute (cover).

Example: When a USB cable is used for connection

a The ScanSnap is turned off and the ScanSnap Manager icon in the Dock changes from

 to .

ATTENTION
l Close the ADF paper chute (cover) after putting the extension back.
l If moving the ScanSnap, first turn the power off and remove all cables.

The bottom part of the ScanSnap may become hot when the ScanSnap is being used but this
does not affect ScanSnap operation or cause any physical harm. Be careful not to drop the
ScanSnap when carrying it.

HINT
l If the Wi-Fi switch is off, the power of the ScanSnap and the computer operate together. If

you keep the ScanSnap connected to the computer, you do not have to worry about turning
the power ON/OFF.

l With some computers, it may take 2 to 3 minutes until the light of the [Scan] button goes out
after the computer is turned off.

l When the ScanSnap is turned off, a notification window notifies you of the ScanSnap's
communication status.
To disable notifications of the ScanSnap's communication status, change the setting in the
following procedure:

1. Click the ScanSnap Manager icon  in the Dock while holding down the [control] key
on the keyboard, and then select [Preferences] from the "ScanSnap Manager Menu"
(page 39).
a The [ScanSnap Manager - Preferences] window appears.

2. Clear the [Notify of the communication status] checkbox in the [Status Display] list.

Turning the ScanSnap On or Off
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Sleep Mode

When the ScanSnap is on and has not been used for 14 minutes, it enters sleep (power saving)
mode.

Turning the ScanSnap On or Off
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Automatic Power OFF

When the ScanSnap is turned on and left unused for the specified time (default is "4 hours"), it will
turn itself off automatically.

To turn the ScanSnap back on, perform one of the following operations:

l Press the [Scan] button on the ScanSnap (this will not start scanning)

l Close the ADF paper chute (cover) and open it again

HINT
l To continue using the ScanSnap, reset the time until auto power-off by performing one of the

following:
- Load a document in the ScanSnap
- Press the [Scan] button on the ScanSnap
- Close the ADF paper chute (cover) and open it again

l You can change the time of the ScanSnap to turn off automatically or change the setting so that it
will not turn off automatically. Set according to the following procedures:

1. Click the ScanSnap Manager icon  in the Dock while holding down the [control] key on the
keyboard, and then select [Preferences] from the "ScanSnap Manager Menu" (page 39).
a The [ScanSnap Manager - Preferences] window appears.

2. In the [Power] list, change the settings for [Power setting] based on how it is connected.
l A notification window notifies you 5 minutes before the ScanSnap turns off automatically.

Turning the ScanSnap On or Off
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Connecting the ScanSnap via Wireless LAN

By connecting the ScanSnap to a computer or a mobile device via wireless LAN, you can scan
documents.

This section explains how to connect the ScanSnap via wireless LAN.

l "Preparation" (page 49)

l "Setting a Wireless LAN Using the ScanSnap Wireless Setup Tool" (page 50)

l "Connecting the ScanSnap to a Computer" (page 51)

l "Connecting the ScanSnap to a Mobile Device" (page 53)

l "Reconnecting to a Wireless Access Point Using the ScanSnap WPS Button" (page 54)

Connecting the ScanSnap via Wireless LAN
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Preparation

To connect the ScanSnap via wireless LAN, prepare the following:

l An environment in which a wireless LAN is available

When connecting the ScanSnap to a wireless access point, you may need information such as
an SSID (network name) and a security key (password).

For details, refer to the manual for the wireless access point.

ATTENTION
Do not place the following within 100 mm (3.9 in.) of the ScanSnap, or near your wireless access
point.
- Obstacles that block radio waves (such as walls and metal plates)
- Devices that may cause signal interference (such as microwaves and cordless phones) and

wireless devices

l ScanSnap Connect Application

To connect the ScanSnap and a mobile device, you need to install ScanSnap Connect
Application on your mobile device.

Download ScanSnap Connect Application for the mobile device from the following application
stores:

- App Store

- Google Play

- Amazon Appstore

Connecting the ScanSnap via Wireless LAN
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Setting a Wireless LAN Using the ScanSnap Wireless Setup Tool

The ScanSnap Wireless Setup Tool is an application to configure the wireless settings required for
connecting your ScanSnap via wireless LAN in a wizard format. The ScanSnap Wireless Setup Tool
can be used to configure and check the following wireless LAN settings and connection.

l Connecting the ScanSnap to a wireless access point

l Registering the computer that will be connected to the ScanSnap via wireless LAN

l Setting the IP address, name, and password for the ScanSnap

l Checking the connection between the ScanSnap and the mobile device

Follow the procedure below to start the ScanSnap Wireless Setup Tool and configure the wireless
settings.

1. From the sidebar in Finder, select [Applications] → [ScanSnap], and then
double-click [ScanSnap Wireless Setup Tool].
a The ScanSnap Wireless Setup Tool will start running.

2. Click the [Wireless Network Setup Wizard] button  in the main
menu.
a The Wireless Network Setup Wizard appears.

3. Follow the instructions in the Wireless Network Setup Wizard to configure
the wireless settings.

HINT
l For details and operation of ScanSnap Wireless Setup Tool, refer to the ScanSnap Wireless Setup

Tool Help.
l The ScanSnap Wireless Setup Tool is also started up when the ScanSnap software is installed.

Connecting the ScanSnap via Wireless LAN
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Connecting the ScanSnap to a Computer

You can use the ScanSnap Wireless Setup Tool Wizard to complete the preparation for connecting
the ScanSnap to a computer.

For details, refer to "Setting a Wireless LAN Using the ScanSnap Wireless Setup Tool" (page 50).

The following explains how to connect the ScanSnap and a computer when the wireless settings
have already been configured by using the ScanSnap Wireless Setup Tool Wizard.

1. Disconnect the USB cable connecting the ScanSnap to the computer.

ATTENTION

If the ScanSnap Manager icon is , exit ScanSnap Connect Application on the mobile
device.

a The ScanSnap is automatically connected to the computer via wireless LAN and the

ScanSnap Manager icon changes to .

If the icon does not change, go to step 2.

HINT
l If the [Connect automatically to the last connected ScanSnap by Wi-Fi] checkbox is selected

and the last connected ScanSnap is available, the computer is connected to the ScanSnap
automatically.

l The computer can be connected to only one ScanSnap.
l Only one computer can be connected to the ScanSnap.
l When you automatically connect a computer and the ScanSnap that had been connected via

wireless LAN before, if the password for the ScanSnap to be connected is changed, a
notification window notifies you of the status.

2. Click the ScanSnap Manager icon  in the Dock while holding down the
[control] key on the keyboard, and then select [Connect by Wi-Fi] from the
"ScanSnap Manager Menu" (page 39).
a The [ScanSnap Manager - Connect by Wi-Fi] window appears.

3. From the list of the ScanSnap units to be connected, select the ScanSnap
that you want to connect, and click the [Connect] button.

ATTENTION
l If the [ScanSnap Manager - Enter Destination Password] window appears, enter the

password to connect.
The default password is the last four digits of the ScanSnap serial number.
The password can be changed with the ScanSnap Wireless Setup Tool. For details, refer to
the ScanSnap Wireless Setup Tool Help.

l If the intended ScanSnap for connection does not appear in the list of the ScanSnap units to
be connected, refer to the ScanSnap Manager Help.

Connecting the ScanSnap via Wireless LAN
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a The ScanSnap is connected to a computer via wireless LAN and the ScanSnap Manager

icon changes to .

HINT
When the ScanSnap and a computer are connected via wireless LAN, a notification window
notifies you of the communication status.

Connecting the ScanSnap via Wireless LAN

52



Connecting the ScanSnap to a Mobile Device

By using the ScanSnap Wireless Setup Tool Wizard, you can configure and check the connection
between the ScanSnap and a mobile device.

For details, refer to "Setting a Wireless LAN Using the ScanSnap Wireless Setup Tool" (page 50).

The following explains how to connect the ScanSnap and a mobile device when the wireless settings
have already been configured by using the ScanSnap Wireless Setup Tool Wizard.

1. Start ScanSnap Connect Application on your mobile device.
a The mobile device will automatically be connected to an available ScanSnap on the same

network.

HINT
l If more than one available ScanSnap is detected, or if ScanSnap Connect Application is set

not to connect a mobile device to a ScanSnap automatically, then tap the ScanSnap that you
want by name, in order to connect to the mobile device, under [ScanSnap] on the [Connect
to] screen. For details, refer to the Basic Operation Guide (Mobile Connection) for your
mobile device.

l A notification window notifies you in the following cases:
- When the ScanSnap and the mobile device are connected via wireless LAN, and the

communication with ScanSnap Manager is disconnected
- When you log into the computer which is connected to the ScanSnap with the ScanSnap

and the mobile device already connected via wireless LAN

Connecting the ScanSnap via Wireless LAN
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Reconnecting to a Wireless Access Point Using the ScanSnap
WPS Button

If the Wi-Fi indicator lights up or flashes in orange, reconnect the ScanSnap to a WPS compatible
wireless access point. The reconnection can be established easily by pressing the WPS button on
the ScanSnap.

ATTENTION
Perform the following before you connect using the WPS button.
l If the ScanSnap Wireless Setup Tool is running while the ScanSnap is being connected to the

computer with a USB cable, exit the ScanSnap Wireless Setup Tool.
l If scanning is currently being performed from ScanSnap Manager or a mobile device, end the

scanning operation.

HINT
Button names and operating procedures may differ depending on the wireless access point. For
details, refer to the manual for your wireless access point.

1. Turn on the ScanSnap.
For details, refer to "Turning the ScanSnap On" (page 43).

2. Turn on the Wi-Fi switch on the back of the ScanSnap.

Wi-Fi

OFF ON

Wi-Fi switch

a After blinking blue, the Wi-Fi indicator lights up in blue or orange.

3. Press the WPS button of the wireless access point.

Connecting the ScanSnap via Wireless LAN

54



4. Press and hold (3 seconds or longer) the WPS button on the back of the
ScanSnap within 2 minutes after pressing the WPS button of the wireless
access point.

WPS Button

a The ScanSnap is connected to the wireless access point and the Wi-Fi indicator lights up in
blue.

If connection cannot be established, the Wi-Fi indicator blinks or lights up in orange.

ATTENTION
If you cannot connect the ScanSnap to a wireless access point, refer to "Troubleshooting" in the
ScanSnap Manager Help.

HINT
For details about the Wi-Fi indicator status, refer to "Parts and Functions" (page 32).

Connecting the ScanSnap via Wireless LAN
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Documents to Scan

This section explains about the conditions for documents that can be loaded directly into the
ScanSnap and the conditions for documents that can be scanned using the Carrier Sheet.

l "Documents That Can Be Loaded Directly into the ScanSnap" (page 57)

l "Documents That Can Be Scanned Using the Carrier Sheet" (page 59)

Documents to Scan
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Documents That Can Be Loaded Directly into the ScanSnap

Conditions for documents that can be loaded directly into the ScanSnap are as follows:

Document type Office paper, postcards, business cards
Plastic cards conforming to the ISO7810 ID-1 type (54 × 86 mm/2.1 × 3.4 in.)

Paper weight 40 to 209 g/m2 (10.7 to 55.7 lb)

Long page documents
52 to 127 g/m2 (13.9 to 33.9 lb)

A8 size (52 × 72 mm) or less
127 to 209 g/m2 (33.9 to 55.7 lb)

Plastic cards
0.76 mm (0.03 in.) or less (embossed cards can be used)

Paper size Width
50.8 to 216 mm (2 to 8.5 in.)

Length
50.8 to 360 mm (2 to 14.17 in.)
For long page (*1), up to 863 mm (34 in.)

*1: Scanning starts when you hold down the [Scan] button on the ScanSnap for 3 seconds or longer.

�������
If you scan a magnetic card or IC card, do not bring the black magnetic part in
contact with the magnetic part of the ADF top section. Otherwise, the data on
the card may be lost.

Magnets

 

ATTENTION
l The following types of documents must not be scanned:

- Documents attached with the metals such as paper clips or staples that can damage the inside
of the ScanSnap
Remove the metals for scanning.

- Documents on which the ink is still wet
Wait until the ink dries completely to scan these documents.
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- Documents larger than 216 × 863 (mm)/8.5 × 34 (in.) (width × length)
- Documents other than paper such as fabric, metal foil and OHP film

l When you scan picture postcards, be aware that the picture side may get damaged. It is the
responsibility of the customer to scan picture postcards.

l When you scan plastic cards, in [Multifeed Detection] of the [Paper] tab of the "ScanSnap Setup
Window" (page 41), select [None] or [Check Length].

l Be careful of the following when you scan plastic cards:
- Cards that are bent may not be fed properly.
- If the surface of the card is dirty with grease marks such as fingerprints, perform scanning after

wiping the dirt off.
- When you scan plastic cards with strong luster, some parts of the image may appear lighter or

darker than the original.

Example: gold colored credit card
- When you scan embossed cards, put the embossed side down, and load the card in landscape

orientation.
- If the embossed characters are not coated in gold or silver and the background color of the card

and the color of the embossed characters are similar, it may be difficult for the ScanSnap to
recognize embossed characters.
In which case, performing the following may result in an improvement.
1. Click the [Option] button in the [Scanning] tab of the "ScanSnap Setup Window" (page 41).

a The [Scanning mode option] window appears.

2. Select the [Increase text contrast] checkbox.
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Documents That Can Be Scanned Using the Carrier Sheet

The bundled Carrier Sheet is a sheet designed to transport documents through the ScanSnap.

You can scan documents that are larger than A4/Letter size, photographs, and clippings.

Conditions for documents that can be scanned using the Carrier Sheet are as follows:

�������
l Do not use a damaged Carrier Sheet. Otherwise, it may damage or cause

the ScanSnap to malfunction.

l Be careful not to cut your finger on the edge of the Carrier Sheet.
 

Document type Documents that cannot be loaded directly into the ScanSnap

Paper weight Up to 209 g/m2 (55.7 lb)

When scanning documents folded in half:
Up to 104.5 g/m2 (27.9 lb)

Paper size Carrier Sheet size (216 × 297 mm)
A3 (297 × 420 mm) (*1)
A4 (210 × 297 mm)
A5 (148 × 210 mm)
A6 (105 × 148 mm)
B4 (257 × 364 mm) (*1)
B5 (182 × 257 mm)
B6 (128 × 182 mm)
Postcard (100 × 148 mm)
Business card (90 × 55 mm, 55 × 90 mm)
Letter (8.5 × 11 in. (216 × 279.4 mm))
11 × 17 in. (279.4 × 431.8 mm) (*1)

Custom size
Width: 25.4 to 216 mm (1 to 8.5 in.)
Length: 25.4 to 297 mm (1 to 11.69 in.)

*1: Fold in half to scan.

Documents for Which the Carrier Sheet is Recommended for
Scanning
It is recommended that you use the Carrier Sheet to scan the following documents.

l Documents written in pencil

Because there may be black traces left on the documents, it is recommended that you use the
Carrier Sheet to scan such documents.

When you scan such documents directly without using a Carrier Sheet, dirt will accumulate on
the rollers, which may cause feeding errors. Clean the rollers occasionally.

For details about how to perform cleaning, refer to "Cleaning the Inside of the ScanSnap" (page
100).

l Carbonless paper
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Because carbonless paper may contain chemicals that can harm the ScanSnap internal rollers, it
is recommended that you use the Carrier Sheet to scan such documents.

Make sure to clean the rollers occasionally to maintain the scanner performance when scanning
carbonless paper directly without using the Carrier Sheet. For details about how to perform
cleaning, refer to "Cleaning the Inside of the ScanSnap" (page 100).

Depending on the type of carbonless paper, the life span of the scanner may be shortened
compared to scanning office paper.

l Scanning the following types of documents without using the Carrier Sheet can result in
documents being damaged or scanned incorrectly

- Documents smaller than 50.8 × 50.8 (mm)/2 × 2 (in.) (width × length)

- Documents whose paper weight is less than 40 g/m2 (10.7 lb)

- Documents with an uneven surface (such as envelopes and paper sheets with attached
materials)

- Wrinkled or curled documents

- Folded or torn documents

- Tracing paper

- Coated paper

- Photographs (photographic paper)

- Perforated or punched documents

- Documents that are not rectangular or square

- Carbon paper or thermal paper

- Documents with memo papers or sticky notes attached

ATTENTION
l Using the Carrier Sheet

Be careful of the following when you use the Carrier Sheet:
- Do not stain, or cut the end with a black & white pattern. Otherwise, the Carrier Sheet will not be

recognized properly.
- Do not place the Carrier Sheet upside down. Otherwise, a paper jam may occur and damage

the Carrier Sheet and the document inside.
- Do not fold or pull the Carrier Sheet.
- Paper jams may occur when several small size documents such as photographs and postcards

are placed inside the Carrier Sheet to be scanned at once. It is recommended that you scan
such documents one at a time.

- If paper jams occur frequently, feed about 50 sheets of PPC paper (recycled paper) before
scanning with the Carrier Sheet. The PPC paper can either be blank or printed.

l Storing the Carrier Sheet
Be careful of the following when you store the Carrier Sheet:
- Do not leave your document inside the Carrier Sheet for a long time. Otherwise, the ink on the

document may be transferred onto the Carrier Sheet.
- Do not leave the Carrier Sheet in high temperature places such as under direct sunlight or near

a heating apparatus for a long time. Also, do not use the Carrier Sheet in high temperature
places. The Carrier Sheet may be deformed.

- To avoid deformation, store the Carrier Sheet on a flat surface without any weight on it.
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What You Can Do with Related Software

This section explains the basic operation procedure of software related to the ScanSnap and gives
an overview of its functions.

l "What You Can Do with the ScanSnap Organizer" (page 62)

l "What You Can Do with CardMinder" (page 67)
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What You Can Do with the ScanSnap Organizer

ScanSnap Organizer is an application used for displaying, organizing, and managing image data
(PDF or JPEG files) scanned with the ScanSnap.

You can use this application to create folders and arrange files for various uses.

Pages of a PDF file can be opened with an associated application to check the scanned image data.

Main Window

Scan documents with the ScanSnap

l "Basic Operation Procedure of ScanSnap Organizer" (page 63)

l "Managing Files" (page 64)

l "Using Files" (page 66)
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Basic Operation Procedure of ScanSnap Organizer

This section explains the basic operation procedure of ScanSnap Organizer.

1. From the sidebar in Finder, select [Applications] → [ScanSnap Organizer],
and then double-click [ScanSnap Organizer] to start up ScanSnap Organizer.

2. Scan documents with the ScanSnap.
a A list of scanned images is displayed in ScanSnap Organizer.
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Managing Files

For details about operations, refer to the ScanSnap Organizer Help.

Setting a Marked Character String as a Keyword
Keywords can be set to a PDF file by using the keyword setting function.

These keywords can be used when you search for PDF files.

When black and white documents that have been marked are scanned by the ScanSnap, the
marked character strings are set as keywords for the PDF file.

Mark the characters 
on a document

"Proposal" can be used as a keyword 
to search for the file

Document PDF file with a keyword

Proposal

Proposal

Scan the document 
with the ScanSnap

Recognizing a Character String in a Page to Embed It into the Page
By using text recognition (OCR) software, you can embed character strings into the page of a PDF
file scanned by the ScanSnap, and then search the PDF file using the character strings.

OCR recognizes "proposal" 
as textual information.

PDF file

"Proposal" can be used 
as a keyword 
to search for the fileProposal
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Searching Files
You can search files that are managed in ScanSnap Organizer.
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Using Files

For details about operations, refer to the ScanSnap Organizer Help.

Linking Files with Other Applications
You can use files with a variety of applications.

Sending Files by E-mail
Files can be sent by e-mail.

Using Files by Syncing with a Mobile Device
By using the ScanSnap Sync function, an image file scanned by the ScanSnap can be synced
automatically with a mobile device and can be used easily anytime or anywhere via a cloud service.

The files are organized and managed in the "ScanSnap Sync" folder in ScanSnap Organizer.

Syncing Files Made up of Images That Were Saved Together ("JPEG
(Save together)" Files)
Using the ScanSnap Sync function allows you to sync "JPEG (Save together)" files between a
mobile device and ScanSnap Organizer.

A "JPEG (Save together)" file consists of multiple images that are scanned with ScanSnap Connect
Application.
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What You Can Do with CardMinder

CardMinder is an application used for displaying, organizing, and managing card image data
scanned with the ScanSnap.

This application digitalizes large amounts of business cards into images at a high speed and
recognizes text on those cards, thus allowing you to search for your clients' business cards from
those data quickly, and create your client databases conveniently. CardMinder uses an Optical
Character Recognition (OCR) engine to recognize text on cards and shares the data with Personal
Information Manager (PIM) applications.

CardMinder also enables business card data to be quickly searched from other applications.

Card

CardMinder window

Scan using ScanSnap

Recognized data

Share the recognized data with PIM
(Example: Contacts)

l "Basic Operation Procedure of CardMinder" (page 69)

l "Linking Card Data with Other Applications" (page 72)

l "Searching Card Data with the Basic Search Toolbar" (page 73)

l "Searching Card Data with Keyboard Shortcuts" (page 74)
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l "Attaching a File to Card Data" (page 75)
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Basic Operation Procedure of CardMinder

This section explains the basic operation procedure of CardMinder.

1. Start CardMinder.
From the sidebar in Finder, select [Applications] → [CardMinder], and then double-click
[CardMinder].

2. Scan a card with the ScanSnap.
Load a card in the ScanSnap and press the [Scan] button to start scanning the card.

When scanning is complete, the information printed on the card (such as name, company, and
address) is automatically recognized as text and displayed in the Card Data Edit view.

The image data scanned from the card is displayed in the Card Image view.

ATTENTION
ScanSnap Manager must be installed on your computer when you want to recognize the
following languages:
l Chinese (simplified)
l Chinese (traditional)
l Korean

3. Check the card data.
Make sure that the front and back card images are correct, and that the text on the card
images are displayed correctly in the Card Data Edit view.
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Card Data Edit ViewCard Image View

4. If the language to be used for text recognition is different, perform text
recognition again in the following procedure:
1. Select [CardMinder] menu → [Preferences].

a The [General] window appears.

2. Select a language for the character strings to be recognized from [Recognition Language].

a The recognition language changes.

3. Close the [General] window.

4. Click the [Recognize] button on the Toolbar again.

a Character strings on the card data will be recognized as the selected language.

What You Can Do with CardMinder

70



5. Correct the card data, if necessary.
The card data can be corrected in the following ways. For details, refer to the CardMinder
Help.

l Redoing the recognition process on the character strings in the selected areas

l Entering text directly in the Card Data Edit view

l Correcting the orientation of the card image or switching the front and back images

3 41 2

No. Description

1 Using the [Rotate] button, you can rotate the card image.

2 Using the [Modify Image] button, you can switch the front and back images of the card image, create
double-sided cards, and delete the back image.

3 By selecting character strings in the card image and then clicking the buttons of the appropriate fields in
the Card Data Edit view, you can redo the recognition process on the selected areas.

4 You can directly correct the text of each field in the Card Data Edit view.

6. Exit CardMinder.
Click [CardMinder] menu → [Quit CardMinder] to quit CardMinder.
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Linking Card Data with Other Applications

Click the following buttons on the Toolbar to use card data in a variety of applications.

The following explains an example in which the Toolbar is customized to display the [Application]
button.

1 2 3 4

No. Item Description

1 E-mail You can start an e-mail program, using the e-mail address specified in [E-mail] for
the card data as the destination address.

2 Internet search You can search the URL specified in [Website] for the card data with a web browser.

3 Outputting card data in
a different format

You can output card data in the vCard, CSV, text, or ContactXML format.

4 Linking card data with
another application

You can link card data with another application such as Outlook or Salesforce CRM
to use the card data in the linked application. You can also link card data with USB
media to use the card data on a different computer.

For details, refer to CardMinder Help.

What You Can Do with CardMinder

72



Searching Card Data with the Basic Search Toolbar

This section explains how to search card data with the CardMinder Basic Search Toolbar.

Find (Basic Search Toolbar)

To search card data, type in a search term (such as an individual name or a company name) in the
Basic Search Toolbar.

The search results are displayed in the Card Data List view.
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Searching Card Data with Keyboard Shortcuts

Even when CardMinder is not running, you can search card data by using a character string in
another application (such as TextEdit) as the keyword for searching.

1. Drag the mouse to select a character string you want to search for.

2. Press [command ] + [shift] + [&] keys on the keyboard at the same time.
a While the Card Data Edit view is hidden, CardMinder starts and search is executed.

Card data matching the search conditions is displayed in the Card Data List view.

HINT
l Depending on the keyboard type, you may not have to press the [shift] key.
l If the keyboard shortcuts do not work, check the [Search Selected Text in CardMinder] shortcut key

by selecting [System Preferences] → [Keyboard] → [Services] in the [Keyboard Shortcuts] tab, and
change the shortcut key to the one to be used.
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Attaching a File to Card Data

A file can be attached to card data easily by dragging and dropping it.
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Useful Usages

This section explains how to use related software for the scanned image that is created after a
document is scanned with the ScanSnap and how to scan a document with a setting other than the
default setting.

l "Managing Paper Documents by Folder on a Computer" (page 77)

l "Saving Business Cards to a Computer" (page 80)

l "Scanning Documents Larger Than A4 or Letter Size" (page 83)

l "Scanning Documents Such as Photographs and Clippings" (page 87)

Useful Usages
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Managing Paper Documents by Folder on a Computer

This section explains how to digitize paper documents and manage the data by folder in ScanSnap
Organizer.

1. Scan a paper document with the ScanSnap.
For details about scanning a document, refer to "Scanning a Document" (page 16).

a The Quick Menu appears.

2. Click the [ScanSnap Organizer] icon  in the Quick Menu.
a The [ScanSnap Organizer] window appears.

Managing Paper Documents by Folder on a Computer
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3. From the menu bar, select [File] → [New Folder].
a A new folder is created in the folder list.

4. Rename the created folder.

HINT
To create multiple folders, repeat steps 3 to 4.

5. Select the scanned image from the file list, and drag and drop it to the folder.

Managing Paper Documents by Folder on a Computer
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a The scanned image is moved to the folder.

HINT
For details about other functions, refer to the ScanSnap Organizer Help.
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Saving Business Cards to a Computer

This section explains how to digitize business cards and save the card data in CardMinder.

ATTENTION
If you do not log in as a user with Administrator privileges, you may not be able to link the ScanSnap
with another application properly.

1. Scan business cards with the ScanSnap.
For details about scanning business cards, refer to "Scanning a Document" (page 16).

a The Quick Menu appears.

2. Click the [CardMinder] icon  in the Quick Menu.
a The [CardMinder] window appears.

Saving Business Cards to a Computer
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3. Check the card data.
Make sure that the text on the card images are displayed correctly in the Card Data Edit view.

If the card data must be corrected, click the text to be corrected and then directly edit it.

Card Data Edit ViewCard Image View
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HINT
When you scan double-sided business cards, you must scan one side of each card and edit the card
data in CardMinder.
For details, refer to the CardMinder Help.
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Scanning Documents Larger Than A4 or Letter Size

Documents larger than A4/Letter size (such as A3, 11 × 17 in. and B4) can be scanned with the
Carrier Sheet. By folding the document in half and scanning in duplex mode, the two sides are
merged into a single image.

For details about documents that can be loaded, refer to "Documents That Can Be Scanned Using
the Carrier Sheet" (page 59).

ATTENTION
The [Deskew by text on document] checkbox in the [Scanning mode option] window will be disabled.
To open the [Scanning mode option] window, click the [Option] button in the [Scanning] tab of the
"ScanSnap Setup Window" (page 41).

HINT
Both sides of a double-sided A4/Letter size document or smaller can also be scanned and merged into
a single image.

1. Click the ScanSnap Manager icon  in the Dock while holding down the
[control] key on the keyboard, and then select [Settings] from the "ScanSnap
Manager Menu" (page 39).
a The ScanSnap setup window appears.

2. In the [Paper] tab, select [Automatic detection] in [Paper size], and then click
the [Carrier Sheet Settings] button.

a The [Carrier Sheet Settings] window appears.

3. Select [one double-page spread image] in [Save as] and click the [OK]
button.

Scanning Documents Larger Than A4 or Letter Size
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For details, refer to the ScanSnap Manager Help.

4. In [Scanning side] in the [Scanning] tab, select [Duplex Scan (Double-sided)]
and click the [Apply] button.

ATTENTION
If [Simplex Scan (Single-sided)] is selected, the ScanSnap outputs the same result as performing
a simplex scan in [two separate images (front and back)] mode.
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5. Click  at the upper left of the window to close the ScanSnap setup window.

6. Place the document inside the Carrier Sheet.
1. Fold the document in half with the sides to be scanned facing out.

Fold it tightly and smooth out any creases.

2. Open the Carrier Sheet to bind the document.

Align the fold line with the right edge of the Carrier Sheet so that the document fits in the
upper right-hand corner of the Carrier Sheet.

HINT
Note that the front side of the Carrier Sheet has a black and white pattern at the top and a
thick vertical line in the upper right-hand corner.

7. Place the end with the black and white pattern as the leading edge in the
direction of the arrow.
Secure the Carrier Sheet with the side guides to avoid skewing.

Scanning Documents Larger Than A4 or Letter Size
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8. Press the [Scan] button on the ScanSnap to start a scan.
a Both sides of the document are scanned and saved as one double-page spread image.

ATTENTION
l There may be a line or a gap appearing between the front and back side images. Also when you

scan a thick document in the Carrier Sheet, the scanned image on the left and the scanned image
on the right of a double-page spread image may skew towards each other from the top.
These symptoms may be improved when you place the document in the Carrier Sheet as follows:
- Fold the document properly
- Neatly align the edges of the document with the edges of the Carrier Sheet
- Turn over the Carrier Sheet to the other (reverse) side

l If [Automatic detection] is specified for [Paper size] in the [Carrier Sheet Settings] window, an
optimal size will be selected automatically from the available standard sizes (A3, B4, or 11 × 17 in.)
in [Paper size]. Note that the size of the image may become smaller than the original document
depending on the document.

Example: When characters and illustrations are printed to fit in A4 size in the center of an A3
size document, the scanned image is output in B4 size.

To output the scanned image in its original size, specify the document size in [Paper size].
l Part of the scanned image around where the document is folded may appear missing. In that case,

place the document so that its edge is about 1 mm (0.04 in.) inside from the edge of the Carrier
Sheet.

HINT
Multiple Carrier Sheets can be loaded in the ADF paper chute (cover) and scanned.
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Scanning Documents Such as Photographs and
Clippings

Using the Carrier Sheet allows you to scan documents that can be damaged quite easily such as
photographs, or non-standard size documents that are difficult to load directly such as clippings.

For details about documents that can be loaded, refer to "Documents That Can Be Scanned Using
the Carrier Sheet" (page 59).

ATTENTION
The [Deskew by text on document] checkbox in the [Scanning mode option] window will be disabled.
To open the [Scanning mode option] window, click the [Option] button in the [Scanning] tab of the
"ScanSnap Setup Window" (page 41).

1. Click the ScanSnap Manager icon  in the Dock while holding down the
[control] key on the keyboard, and then select [Settings] from the "ScanSnap
Manager Menu" (page 39).
a The ScanSnap setup window appears.

2. In the [Paper] tab, select [Automatic detection] in [Paper size], and then click
the [Carrier Sheet Settings] button.

a The [Carrier Sheet Settings] window appears.

3. Select [two separate images (front and back)] in [Save as] and click the [OK]
button.
For details, refer to the ScanSnap Manager Help.
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4. Click the [Apply] button in the ScanSnap setup window.

5. Click  at the upper left of the window to close the ScanSnap setup window.

6. Place the document inside the Carrier Sheet.
Open the Carrier Sheet and place the top of the document against the top center of the Carrier
Sheet.

7. Place the end with the black and white pattern as the leading edge in the
direction of the arrow.
Place the back side of the document towards you.

Secure the Carrier Sheet with the side guides to avoid skewing.
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Back

8. Press the [Scan] button on the ScanSnap to start a scan.
a When scanning is completed, the scanned image is saved.

ATTENTION
l The scanned image is output at the center of the page in the size specified for [Paper size] in the

[Carrier Sheet Settings] window.
l If [Automatic detection] is specified for [Paper size] in the [Carrier Sheet Settings] window, an

optimal size will be selected automatically from the available standard sizes (A3, B4, or 11 × 17 in.)
in [Paper size]. Note that the size of the image may become smaller than the original document
depending on the document scanned, or part of the image may appear missing.

Example: When the contents are printed to fit in A5 size in the center of an A4 size document,
the scanned image is output in A5 size.

To output the scanned image in its original size, specify the document size in [Paper size].

HINT
l In the following cases, place a blank (white) sheet of paper underneath the document when

scanning:
- The scanned image is not saved in the correct size (when [Automatic detection] is selected for

[Paper size] in the [Carrier Sheet Settings] window)
- Shadows appear around the edges of the scanned image
- Black lines appear around the edges of a uniquely shaped cutting

l Multiple Carrier Sheets can be loaded in the ADF paper chute (cover) and scanned.
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Troubleshooting

This section explains how to solve troubles you may encounter upon installing the software related
to the ScanSnap.

l "If You Have Installed the Software Before" (page 91)

l "When the ScanSnap Manager Icon Does Not Appear" (page 92)

l "When ScanSnap Manager Does Not Operate Normally" (page 94)

For details about the troubles you may encounter and the solutions while using the ScanSnap, refer
to the following:

l "Troubleshooting" in the ScanSnap Manager Help

To display this section, click the ScanSnap Manager icon  in the Dock while holding down
the [control] key on the keyboard, and select [Help] → [Troubleshooting] from the "ScanSnap
Manager Menu" (page 39).

l ScanSnap Support Site (http://scansnap.fujitsu.com/g-support/en/)

If you cannot solve the problem after referring to the above section, contact your FUJITSU scanner
dealer or an authorized FUJITSU scanner service provider.

Troubleshooting
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If You Have Installed the Software Before

If your attempt to reinstall the software related to the ScanSnap (including models other than iX500)
failed, uninstall the software and then reinstall it.

For details, refer to the following:

l "Uninstalling the Software" (page 117)

l "How to Install the Software" (page 37)
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When the ScanSnap Manager Icon Does Not Appear

This section explains how to troubleshoot when the ScanSnap Manager icon  does not appear
in the Dock even though the software is installed and the ScanSnap is connected to the computer.

l "Displaying the ScanSnap Manager Icon" (page 93)

When the ScanSnap Manager Icon Does Not Appear
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Displaying the ScanSnap Manager Icon

1. From the sidebar in Finder, select [Applications] → [ScanSnap], and then
double-click [ScanSnap Manager] to start ScanSnap Manager.

HINT
If the problem is solved, you can change the setting so that ScanSnap Manager will start up
automatically from the next time you log in to the computer.
The procedure is as follows.

l On the [System Preferences] window displayed from the Apple ( ) menu, select [Users &

Groups] → [Current User] → [Login Items] → [ ] → [ScanSnap] → [ScanSnap Manager].

l Click the ScanSnap Manager icon  in the Dock while holding down the [control] key on
the keyboard, and then select [Options] → [Open at Login] from the displayed menu.

If the problem persists, refer to "When ScanSnap Manager Does Not Operate Normally" (page 94).

When the ScanSnap Manager Icon Does Not Appear

93



When ScanSnap Manager Does Not Operate
Normally

If the ScanSnap Manager icon in the Dock is displayed as  even though the software is
installed and the ScanSnap is connected to the computer, perform the following procedures.

l "Checking the Connection between the ScanSnap and the Computer" (page 95)

l "Checking If ScanSnap Manager Is Operating Normally" (page 96)
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Checking the Connection between the ScanSnap and the
Computer

1. Unplug the USB cable from the computer and the ScanSnap, then plug it
back in.
Make sure to leave at least 5 seconds between unplugging and plugging the cable.

If you are using a USB hub, connect the USB cable to the computer directly.

If the problem persists, refer to "Checking If ScanSnap Manager Is Operating Normally" (page 96).
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Checking If ScanSnap Manager Is Operating Normally

1. Turn off the ScanSnap and then turn it on again.
Make sure to leave at least 5 seconds between turning off and on the ScanSnap.

If the problem persists, proceed to step 2.

2. If you are using a USB hub, connect the ScanSnap to the computer directly
with a USB cable.

If the problem persists, proceed to step 3.

3. Turn off the ScanSnap and restart the computer.

If the problem persists, refer to "If You Have Installed the Software Before" (page 91). If the problem still persists,
perform the procedures described in "When ScanSnap Manager Does Not Operate Normally" (page 94) once
again.
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Cleaning

This section explains about the cleaning materials and how to clean the ScanSnap.

ATTENTION
The bottom part of the ScanSnap may become hot when the ScanSnap is being used but this does not
affect ScanSnap operation or cause any physical harm. Be careful not to drop the ScanSnap when
carrying it.

l "Cleaning Materials" (page 98)

l "Cleaning the Outside of the ScanSnap" (page 99)

l "Cleaning the Inside of the ScanSnap" (page 100)

l "Cleaning the Carrier Sheet" (page 104)
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Cleaning Materials

Cleaning materials and their part numbers are as below.

Product Name Part No. Unit Note

Cleaner F1 PA03950-0352 1 bottle Size: 100 ml

Cleaning Paper (*1) CA99501-0012 1 pack 10 sheets

Cleaning Wipe (*2)

PFU Limited

PA03950-0419 1 pack 24 packets

Lint-free dry cloth (*3) Commercially
available

- -

*1: Used with Cleaner F1.

*2: The cleaning wipes are wet tissues that have been soaked with Cleaner F1. In place of this
product, you can use a cloth soaked with Cleaner F1.

*3: Any lint-free cloth can be used.

Contact your FUJITSU scanner dealer or an authorized FUJITSU scanner service provider for
details about purchasing the cleaning materials.

For details, refer to the following web page:

http://scansnap.fujitsu.com/

Cleaning Materials
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Cleaning the Outside of the ScanSnap

Clean the outside of the ScanSnap, the ADF paper chute (cover), the ADF top section, and the
stacker in the following procedure.

1. Unplug the cables from the ScanSnap.

2. Clean the outside of the ScanSnap with a dry cloth, or a cloth moistened with
Cleaner F1/mild detergent.

ATTENTION
l Never use paint thinner or any other organic solvents. The shape or color may be changed.
l When cleaning the ScanSnap, prevent liquids from entering the ScanSnap.
l It may take a long time for Cleaner F1 to dry if an excessive amount is used. Moisten the

cloth with moderate quantity. Wipe off the cleaner completely with a soft cloth to leave no
residue on the cleaned parts.

Cleaner F1 or
Mild DetergentCloth

Cleaning the Outside of the ScanSnap
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Cleaning the Inside of the ScanSnap

Scanning repeatedly may cause dust and paper dust to accumulate inside the ScanSnap resulting in
a scanning error.

As a guideline, the inside of the ScanSnap should be cleaned every 1,000 sheets scanned. Note
that this guideline varies depending on the types of documents you scan. For instance, it may be
necessary to clean the scanner more frequently when you scan documents on which the toner is not
sufficiently fused.

�������
l Before cleaning the ScanSnap, you must turn off the ScanSnap and unplug

the power cable from the AC outlet. Not doing so may cause fire or electrical
shock.

l Do not place internal parts such as the brake roller and the pick roller within
reach of small children. Doing so may cause injury.

l When the ScanSnap is operating, the internal glass surface will be hot.

Before you clean the inside of the ScanSnap, you must unplug the power
cable from the AC outlet and leave the ScanSnap for 15 minutes or more.

 

�������
Do not use aerosol spray or spray that contains alcohol to clean the scanner.
Paper dust and other dust blown up by strong air from the spray may enter the
inside of the scanner which may cause scanner failure or malfunction.

Also note that sparks generated by static electricity may cause a fire.
 

ATTENTION
l Do not use water or mild detergent to clean the inside of the ScanSnap.
l It may take a long time for Cleaner F1 to dry if an excessive amount is used. Moisten the cloth with

moderate quantity.
Wipe off the cleaner completely to leave no residue on the cleaned parts.

HINT
To check the number of sheets scanned with the ScanSnap, see [Total Page Count] in the [ScanSnap
Manager - Check consumable status] window.
To open the [ScanSnap Manager - Check consumable status] window, click the ScanSnap Manager

icon  in the Dock while holding down the [control] key on the keyboard, and select [Check
consumable status] from the "ScanSnap Manager Menu" (page 39).

1. Clean the following items:
l Brake roller

l Idler roller

l Glass

l Pick roller

l Ultrasonic sensor

1. Unplug the power cable from the AC outlet.

Cleaning the Inside of the ScanSnap
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2. Pull the ADF release tab to open the ADF top section.

ADF Paper Chute (Cover)

ADF Release Tab
ADF Top Section

3. Clean the following locations with a cloth moistened with Cleaner F1.

ATTENTION
When cleaning, be careful not to damage the document sensor with a cloth.

Document Sensor

Brake Roller (x2)

Pick Roller (x2)

Ultrasonic Sensor (x2)

Scan Glass (x2)

Idler Roller (x4)

l Brake roller (× 2)

Remove the brake rollers from the ScanSnap to clean them.

For details about how to remove the brake rollers, refer to "Replacing Consumables"
(page 108).
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Gently wipe off the dirt and dust along the grooves on the roller surface. Be careful not
to damage the surface of the rollers.

l Idler roller (× 4)

Gently wipe the dirt and dust off the rollers as you rotate them manually. Be careful not
to damage the surface of the rollers. Make sure that they are cleaned properly because
residue on the rollers will affect the feeding performance.

l Glass (× 2)

Gently wipe the dirt and dust off the surface of the glass sections. Make sure that they
are cleaned properly because dirty glass sections may cause vertical lines on scanned
images.

l Pick roller (× 2)

Gently wipe off the dirt and dust along the grooves on the surface of rollers as you
manually rotate them downward. Be careful not to damage the surface of the rollers.
Make sure that they are cleaned properly because residue on the rollers will affect the
feeding performance.

l Ultrasonic sensor (× 2)

Gently wipe the dirt and dust off the surface of the ultrasonic sensor. If it is difficult to
clean the ultrasonic sensor, use cotton swabs.

2. Clean the feed rollers and eject rollers.
1. Connect the power cable to the AC outlet and press the [Scan] button for three seconds

with the ADF top section open.

ATTENTION
Connect the power cable to the AC outlet only when cleaning the feed rollers and eject
rollers.

2. Clean the following locations with a cloth moistened with Cleaner F1.
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Eject Roller (x2)

Feed Roller (x2)

l Feed roller (× 2)/eject roller (× 2)

Press the [Scan] button to rotate the rollers. Gently wipe the dirt and dust off while
taking care not to damage the surface of each roller. Make sure that they are cleaned
properly because residue on the rollers will affect the feeding performance.

HINT
Pressing the [Scan] button seven times will rotate the feed rollers and the eject rollers
one revolution.

3. Close the ADF top section.

ADF Paper Chute (Cover)

ADF Top Section

a It clicks when it returns to its original position.

ATTENTION
Make sure that the ADF top section is completely closed.
Otherwise, paper jams or other feeding errors, or image faults may occur.
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Cleaning the Carrier Sheet

As you keep using the Carrier Sheet, dirt and dust will accumulate on the surface and the inside.

Clean the Carrier Sheet regularly because it may result in scanning errors.

The procedure for cleaning the Carrier Sheet is as follows.

Cleaning
Gently wipe the dirt and dust off the surface and the inside of the Carrier Sheet with a dry cloth, or a
cloth moistened with Cleaner F1/mild detergent.

ATTENTION
l Do not use paint thinner or any other organic solvents.
l Do not use force to rub. The Carrier Sheet may be damaged or deformed.
l Be careful not to leave any crease on the Carrier Sheet.
l After cleaning the inside of the Carrier Sheet with a cloth moistened with Cleaner F1/mild detergent,

make sure that it is completely dry before closing the Carrier Sheet.
l The Carrier Sheet should be replaced approximately every 500 scans.
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Consumables

This section explains about the consumable part numbers, replacement cycles and how to replace
the consumables.

�������
l Before replacing consumables, you must turn off the ScanSnap and unplug

the power cable from the AC outlet. Not doing so may cause fire or electrical
shock.

l Do not place internal parts such as the brake roller and the pick roller within
reach of small children. Doing so may cause injury.

 

ATTENTION
The bottom part of the ScanSnap may become hot when the ScanSnap is being used but this does not
affect ScanSnap operation or cause any physical harm. Be careful not to drop the ScanSnap when
carrying it.

l "Part Numbers and Replacement Cycle of Consumables" (page 106)

l "Checking the Status of Consumables" (page 107)

l "Replacing Consumables" (page 108)

Consumables
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Part Numbers and Replacement Cycle of
Consumables

The following table shows the part number of the consumables and the suggested replacement
cycles.

Product Name Part No. Suggested replacement cycle

Roller Set
l Brake roller

l Pick roller

PA03656-0001 200,000 sheets or one year

Note that the suggested replacement cycles are guidelines for using A4 (80 g/m2 [20 lb]) wood-free
paper, as these cycles vary depending on the type of documents scanned.

Only use the specified consumables.

Contact your FUJITSU scanner dealer or an authorized FUJITSU scanner service provider for
details about purchasing the consumables.

For details, refer to the following portal site:

http://scansnap.fujitsu.com/

Part Numbers and Replacement Cycle of Consumables
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Checking the Status of Consumables

You can check the status of each consumable in the following procedure.

1. Click the ScanSnap Manager icon  in the Dock while holding down the
[control] key on the keyboard, and then select [Check consumable status]
from the "ScanSnap Manager Menu" (page 39).
a The [ScanSnap Manager - Check consumable status] window appears.

2. Check the status of each consumable.
Refer to [Suggested replacement cycle] as a guideline and replace the consumables.

Checking the Status of Consumables
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Replacing Consumables

The Roller Set consists of the brake roller and pick roller.

Replace each roller in the following procedure:

1. Unplug the power cable from the AC outlet.

2. Remove any documents from the ADF paper chute (cover).

3. Pull the ADF release tab to open the ADF top section.

ADF Paper Chute (Cover)

ADF Release Tab
ADF Top Section

4. Replace the brake roller.
1. Open the brake roller cover.

By holding the both ends of the brake roller cover, open it in the direction of the arrow.

Cover

2. Remove the shaft of the brake roller from the ScanSnap.

Lift the brake roller to remove the right side of the shaft, and then pull out the shaft from the
hole on the left.

Replacing Consumables
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Brake Roller

Shaft

3. Remove the brake roller from the shaft.

Shaft

Brake Roller

4. Attach the new brake roller to the shaft.

Insert the shaft to the brake roller by aligning the protrusion on the shaft with the slot on the
brake roller.

Shaft

Brake Roller

Protrusion

Slot

5. Attach the shaft to the ScanSnap.

Insert the left end of the shaft in the hole properly, and then attach the right side of the
shaft into place.
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Brake Roller
Shaft

6. Close the brake roller cover.

ATTENTION
Make sure that the shaft is attached firmly. Otherwise, paper jams or other feeding errors
may occur.

5. Replace the pick roller.
1. Open the sheet guide.

Slide the side guides all the way. Open the sheet guide by hooking your finger in the dip of
the sheet guide.

Side Guides

Sheet Guide

Dip

2. Turn the bushing in the direction of the arrow.
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Bushing

3. Remove the pick roller.

Lift the right side of the bushing slightly (about 5 mm), move it toward the right, and then lift
it upward to pull out the pick roller.

Bushing

ATTENTION
Be careful not to touch the grease on the gear near the bushing.

4. Attach the new pick roller to the ScanSnap.

Insert the left end of the shaft into the left-side hole, and then slowly attach the right end of
the shaft into place.

Replacing Consumables
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Pick Roller

5. Turn the bushing in the direction of the arrow.

Bushing

ATTENTION
Make sure that the pick roller is attached firmly. Otherwise, paper jams or other feeding
errors may occur.

6. Close the sheet guide.

Make sure that both sides of the sheet guide are locked firmly.

6. Close the ADF top section.

Replacing Consumables
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ADF Paper Chute (Cover)

ADF Top Section

a It clicks when it returns to its original position.

7. Connect the power cable to the AC outlet, and turn on the ScanSnap.

8. Reset the roller set count.

1. Click the ScanSnap Manager icon  in the Dock while holding down the [control] key
on the keyboard, and then select [Check consumable status] from the "ScanSnap Manager
Menu" (page 39).

a The [ScanSnap Manager - Check consumable status] window appears.

2. Click the [Reset] button for [Roller Set Count].

a A confirmation window appears.

3. Click the [Yes] button.

a [Roller Set Count] is reset to 0.

Replacing Consumables
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Appendix

l "Preparations for Using Nuance PDF Converter for Mac" (page 115)

l "Updating the Software" (page 116)

l "Uninstalling the Software" (page 117)

l "Specifications of the Carrier Sheet" (page 124)

l "Specifications of Wireless LAN" (page 125)

l "Specifications of the ScanSnap" (page 126)
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Preparations for Using Nuance PDF Converter for
Mac

For details about the installation and activation methods of Nuance PDF Converter for Mac, refer to
the following web page:

How to Install PDF Editing Software
http://www.pfu.fujitsu.com/imaging/downloads/manual/install/en

Preparations for Using Nuance PDF Converter for Mac
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Updating the Software

Latest updates for ScanSnap related software are available for free from our download server. This
is called ScanSnap Online Update.

It is recommended that you apply latest updates to enhance security, operability and functions.

For the software programs that can be updated, refer to the following:

http://www.fujitsu.com/global/support/computing/peripheral/scanners/software/online-setup-help.html

ScanSnap Online Update checks the download server periodically.

When the latest version of ScanSnap is available, the update list window appears.

To install the update, follow the instructions on the window.

For details, refer to the ScanSnap Online Update Help.

You can also manually check from ScanSnap Manager whether a newer version of the program is
available and run the update.

1. Click the ScanSnap Manager icon  in the Dock while holding down the
[control] key on the keyboard, and click [Help] → [Online Update] from the
"ScanSnap Manager Menu" (page 39).
a ScanSnap Online Update checks whether a newer version of ScanSnap Manager is

available. Proceed with the update as you follow the instructions.

For details, refer to the ScanSnap Online Update Help.

ATTENTION
l To run the online update for ScanSnap Manager, you need to have access to the Internet.
l Log in as a user with Administrator privileges.

HINT
For details about updates of ScanSnap Manager, visit the following web pages:
http://scansnap.fujitsu.com/g-support/en/

Updating the Software
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Uninstalling the Software

This section explains how to uninstall the following software programs:

l "Uninstalling ScanSnap Manager" (page 118)

l "Uninstalling ScanSnap Organizer" (page 120)

l "Uninstalling CardMinder" (page 121)

l "Uninstalling ABBYY FineReader for ScanSnap" (page 122)

l "Uninstalling ScanSnap Online Update" (page 123)

Uninstalling the Software
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Uninstalling ScanSnap Manager

Uninstall ScanSnap Manager.

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. From the sidebar in Finder, select [Applications] → [ScanSnap] → [Sub], and
then double-click [ScanSnap Uninstaller].
a The [ScanSnap Uninstaller] window (the [Welcome to ScanSnap Uninstaller] screen)

appears.

3. Click the [Continue] button.
a The [Important Information] screen appears.

4. Read [Read Me], and then click the [Uninstall] button.
a The authentication window appears.

5. Enter the user name and password for a user with Administrator privileges,
and click the [OK] button.
a Uninstallation starts. When the uninstallation is complete, [Uninstall Succeeded] screen

appears.

6. Click the [Close] button.

HINT
When a user other than the user who uninstalled ScanSnap Manager has set ScanSnap
Manager as a login item, the following operations are required:
1. Log in as a user who has set ScanSnap Manager as a login item.

2. From the Apple ( ) menu, select [System Preferences].
a The [System Preferences] window appears.

3. Select [Users & Groups].
a The [Users & Groups] window appears.

4. From [Current User], select the currently logged-in user.

5. Select the [Login Items] tab.
a A list of login items appears.

6. From the list of login items, select [ScanSnap Manager].

7. Click the [ ] button under the list of login items.
a [ScanSnap Manager] is deleted from the list of login items.
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8. Close the [Users & Groups] window.
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Uninstalling ScanSnap Organizer

Uninstall ScanSnap Organizer.

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. Exit ScanSnap Organizer if it is running.

3. From the sidebar in Finder, select [Applications] → [ScanSnap Organizer],
and drag the [ScanSnap Organizer] folder into the Trash.

4. Empty the Trash.
a The [ScanSnap Organizer] folder is deleted.
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Uninstalling CardMinder

Uninstall CardMinder.

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. Exit CardMinder if it is running.

3. From the sidebar in Finder, select [Applications] → [CardMinder], and drag
the [CardMinder] folder into the Trash.

4. Empty the Trash.
a The [CardMinder] folder is deleted.

HINT
To delete the database, drag the database file into the Trash.
To access the database file stored in the default location, select [Documents] → [CardMinder] →
[CardMinder DB.cxdb] from the sidebar in Finder.
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Uninstalling ABBYY FineReader for ScanSnap

Uninstall ABBYY FineReader for ScanSnap.

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. Exit ABBYY FineReader for ScanSnap if it is running.

3. From the sidebar in Finder, select [Applications] → [ABBYY FineReader for
ScanSnap], and drag the [ABBYY FineReader for ScanSnap] folder into the
Trash.

4. Empty the Trash.
a The [ABBYY FineReader for ScanSnap] folder is deleted.

Uninstalling the Software
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Uninstalling ScanSnap Online Update

Uninstall ScanSnap Online Update.

HINT
Before uninstalling ScanSnap Online Update, make sure that none of the following software is
installed.
l ScanSnap Manager
l ScanSnap Organizer
l CardMinder

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. From the sidebar in Finder, select [Applications] → [ScanSnap Online
Update] → [Sub], and then double-click [AOUUninstaller].
a The [ScanSnap Online Update Uninstaller] window ([Welcome to ScanSnap Online Update

Uninstaller]) appears.

3. Click the [Continue] button.
a The [Important Information] screen appears.

4. Read [Read Me], and then click the [Uninstall] button.
a The authentication window appears.

5. Enter the user name and password for a user with Administrator privileges,
and click the [OK] button.
a Uninstallation starts. When the uninstallation is complete, [Uninstall Succeeded] screen

appears.

Uninstalling the Software
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Specifications of the Carrier Sheet

The product name and part number of the Carrier Sheet are as follows.

Product Name Qty. Part No.

Carrier Sheets 5 sheets PA03360-0013

The Carrier Sheet should be replaced approximately every 500 scans.

However, replace it if damage or dirt is noticeable.

Contact your FUJITSU scanner dealer or an authorized FUJITSU scanner service provider for
details about purchasing the Carrier Sheet.

For details, refer to the following portal site:

http://scansnap.fujitsu.com/

Specifications of the Carrier Sheet
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Specifications of Wireless LAN

The following table summarizes the wireless LAN specifications of the ScanSnap.

Item Specification

Model name iX500

Observed standards IEEE802.11b/IEEE802.11g/IEEE802.11n

Frequency range 2.412 GHz to 2.472 GHz

Channels 1 to 13 ch

Transfer speed (standard) IEEE802.11b Max.: 11 Mbps
IEEE802.11g Max.: 54 Mbps
IEEE802.11n Max.: 72.2 Mbps (Only supports 20 MHz bandwidth) (*1)

Communication mode Infrastructure mode (*2)

Communication distance (line
of sight)

Indoors, 50 m (Recommended: indoors, within 25 m) (*3)

Security WPA-PSK (TKIP/AES), WPA2-PSK (TKIP/AES), WPA (TKIP/AES), WPA2
(TKIP/AES), WEP (64-bit/128-bit)

Easy installation WPS 2.0 supported (button/PIN code) (*4)

*1: The values indicated on these standards are the maximum value, and do not indicate actual
communication speed.

*2: To use the wireless function, you need a wireless access point that supports the same
standards.

*3: The specifications may vary based on the connected wireless access point and the surrounding
environment.

*4: You need a wireless access point that supports the WPS function.
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Specifications of the ScanSnap

The following table summarizes the specifications of the ScanSnap.

Item Specification

Product Name ScanSnap iX500

Scanning method Automatic Document Feeder (ADF), simultaneous duplex
scanning

Scanning color mode Simplex/duplex, color/gray/black and white/auto (automatic
color, gray, and B&W detection)

Optical system/image sensor Selfoc lens equal-magnification optics/color CIS × 2 (front ×
1, back × 1)

Light source 3 color LED (Red/Green/Blue)

Scanning speed (A4 portrait) Automatic resolution/normal/better/best
25 sheets/minute

Excellent
7 sheets/minute

Scan area Refer to "Documents to Scan" (page 56)

Document thickness

Number of sheets allowed to be loaded Up to 50 sheets
A4: 80 g/m2 (20 lb)

Interface USB USB 3.0 (*1)/USB 2.0/USB 1.1 (connector: B type)

Wireless LAN (*2) Refer to "Specifications of Wireless LAN" (page 125)

Input power Voltage 100 to 240 V ±10%

Phase Single phase

Frequency range 50/60 Hz

Power consumption USB connection During operation: 20 W or less
During sleep mode: 1.6 W or less

Wireless LAN connection During operation: 20 W or less
During sleep mode: 2.5 W or less

Temperature/humidity
allowable ranges

Temperature During operation: 5 to 35 degrees C/41 to 95 degrees F
During standby: -20 to 60 degrees C/-4 to 140 degrees F
During storage/transportation: -20 to 60 degrees C/-4 to 140
degrees F

Humidity During operation: 20 to 80%
During standby: 8 to 95%
During storage/transportation: 8 to 95%

Outer dimensions (Width × Depth × Height) Min.: 292 × 159 × 168 mm/11.50 × 6.26 × 6.61 in. (when the
ADF paper chute (cover) is closed)
Max.: 292 × 484 × 293 mm/11.50 × 19.06 × 11.54 in. (when
the ADF paper chute (cover) is open and the extension is
extended)

Weight 3.0 kg (approx. 6.62 lb)

Environmental specification Compliant with the International Energy Star Program, and
RoHS Directive

Specifications of the ScanSnap
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Item Specification

Related Software Scanner driver ScanSnap Manager

File management ScanSnap Organizer

Business card
management

CardMinder

Text recognition ABBYY FineReader for ScanSnap

Update management
and application

ScanSnap Online Update

PDF editing Nuance PDF Converter for Mac

*1: When the ScanSnap is connected to a USB 3.0 port, the ScanSnap may not be recognized by
some computers.

For the latest USB 3.0 information, refer to the ScanSnap Support Site (http://
scansnap.fujitsu.com/g-support/en/).

*2: IPv6 is not supported.

Specifications of the ScanSnap
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About Customer Support and Maintenance

Customer Support
l ABBYY FineReader for ScanSnap

From the sidebar in Finder, select [Applications] → [ABBYY FineReader for ScanSnap] →
[ABBYY FineReader for ScanSnap] → [Help] → [ABBYY FineReader for ScanSnap Help] →
[Technical Support].

l Evernote

Refer to the following web page:

http://www.evernote.com/about/contact/support/

l Google Drive

Refer to the Google Drive Help Center or the Google Product Forums.

To open them, select [Help] in Google Drive.

l Salesforce

Contact the system administrator of your Salesforce.

l Dropbox

Refer to the following web page:

http://www.dropbox.com/contact

l ScanSnap

For other inquiries on the ScanSnap, refer to the ScanSnap Support Site.

http://scansnap.fujitsu.com/g-support/en/

If your problem cannot be solved after referring to the above web pages, visit the following web
page to check the contact information of a suitable Fujitsu office and contact the Fujitsu office.

http://imagescanner.fujitsu.com/warranty.html

Suppliers of Consumables/Optional Parts
http://scansnap.fujitsu.com/

Maintenance
Contact your FUJITSU scanner dealer or an authorized FUJITSU scanner service provider for
repairs on this product.

For details, refer to the following portal site:

http://imagescanner.fujitsu.com/warranty.html

ATTENTION
For safety reasons, never attempt repairs by yourself.
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